Table of Contents

Recommended Sequence of Topics ................................................................. 1

Concepts: Process Analyzer ........................................................................... 2

Introduction ........................................................................................................ 2
Process Analyzer Browser ................................................................................. 3
About Cubes ....................................................................................................... 5
About Views ....................................................................................................... 8
Dimensions and Measures ............................................................................... 9

Getting Started ..................................................................................................10

Overview: Process Analyzer Browser Execution Modes .................................... 10
Opening a Cube or View in Standalone Mode ................................................ 11
Opening a Cube or View in Client / Server Mode ........................................... 12
Opening a Cube or View through HTTP or FTP ............................................. 14
Opening a Cube or View in a New Window ..................................................... 16
Opening a Cube or View Automatically .......................................................... 17
Using the Menu Bar and Toolbar .................................................................... 17
Using the Dimension Bar and Measures List .................................................. 22
Using Process Analyzer Explorer ................................................................. 24
Saving a Cube View ....................................................................................... 27
Creating a New View ...................................................................................... 29
Bookmarking a View ...................................................................................... 29
Creating a New Synchronized View ............................................................... 30
Closing a Cube or View .................................................................................. 32
Changing the GUI Look and Feel ................................................................. 32
Displaying Cube and Cube View Properties ................................................ 34

Using the Process Performance Cube ............................................................36

Overview: Process Performance Cube ............................................................ 36
Dimensions: Process Performance Cube ......................................................... 38
Measures: Process Performance Cube ............................................................ 38
Sample View: Number of Instances Per Activity ......................................... 39
Sample View: Average Time Per Activity ...................................................... 42
Sample View: Average Time Per Process ....................................................... 46
Recommended Sequence of Topics

The following help topics in Using Process Analyzer are designed to familiarize you with Fuego’s Process Analyzer. They are also intended to help you solve specific problems you encounter as you use the tool.

The topics are arranged in order from top to bottom to facilitate your quickly learning the tool. Start with the Concepts: Process Analyzer section to gain a quick understanding of what Process Analyzer is and what is happening behind the scenes as you use it. Next, review the Getting Started with Process Analyzer section. This is a hands-on tutorial designed to get you working right away with Process Analyzer, so that you can be immediately finding and analyzing the information you need about your business’s processes. Once you’ve become familiar with using the Process Analyzer, we recommend that you read the next two sections: Using the Process Performance Cube and Using the WorkloadFull Cube. This will give you a better understanding of the kinds of information available to you.

For help with technical questions not covered in manual, or to request additional training, please go to the Fuego support web site at http://www.fuego.com/supp/.
Concepts: Process Analyzer

Introduction

Process Analyzer is a vital tool for everyday business analysis. It offers instant and clear answers to business questions.

OLAP Tool Provides Business with Operational Intelligence

Process Analyzer is an On-Line Analytical Processing (OLAP) tool. This category of software technology provides analysts, managers and executives with a clear insight into enterprise data through fast, consistent and interactive access. It provides a wide range of analytical functionality that reflect the real dimensionality of the business.

Fuego's Process Analyzer enables business users to review information about their processes and thus, their operations. It provides organizations with true operational intelligence. The process information captured by and stored in Fuego's execution engines is aggregated into a central OLAP data warehouse. This data is then transformed into multidimensional models (or cubes) that reveal process statistics related to workload and performance. Executives, business analysts, and managers can then use the Process Analyzer browser bundled with the Fuego suite of products to view and manipulate these cubes for reporting and analysis purposes.

Wide Range of Analytical Capabilities

Fuego's Process Analyzer allows you to perform the following:

- Calculations and modeling applied across dimensions, through hierarchies and/or across members
- Trend analysis over sequential time periods
- Historical and projected data analysis in various "what if" data model scenarios
- Slicing subsets for on-screen viewing
- Drill-down to deeper levels of consolidation
- Reach-through to underlying detail data
- Rotation to new dimensional comparisons in the viewing area

Methods and techniques for performing all of these analyses are detailed in subsequent topics.

Decision-Making Tool

Enables Informed Decision-Making - Process Analyzer enables decision-makers in a company to make informed, coordinated decisions in a rapid-fire environment where anything less immediate is simply too late. The result is a complete coordination of information and decision-making that moves an entire enterprise together in a unified fashion, as opposed to the more traditionally upward flow of information and downward flow of decisions. Process Analyzer is no longer perceived simply as decision support software. In the new model, decision support represents the tools and technology to support the high-level decision maker.

Solves Real-World Problems - Let’s take a hypothetical example. You are the VP of Sales of Any Company and you are interested in reviewing how long it is taking to
process orders. You also want to determine if there is a backlog or some other problem. Any Company's CEO may want to compare performance of the entire organization by division. Other executives can obtain answers to questions such as "What is the average time from time of order to shipment of product? or "How many orders are reviewed each day?" or "What is the volume of credit checks performed in February 2002 for each finance clerk?" You can find these and the other answers you need with Process Analyzer. You can also use Process Analyzer to uncover hidden patterns and emerging trends.

**Multiple Reporting Options** - You can report these results in traditional database formats. You can also easily create interactive graphical charts that allow you to directly manipulate the data for further analysis. You can identify trends, correlate data, or map-out a series of events. By placing information in a proper frame of reference, Process Analyzer helps you make better informed business decisions.

**Process Analyzer Browser**

Fuego's Process Analyzer browser is the end-user *analysis* component of Fuego's product suite. It is flexible, completely user-friendly and does not require extensive training. The Process Analyzer Browser provides access to your WorkloadFull and Process Performance cubes and allows you to navigate through them in an intuitive way, without requiring detailed knowledge of the underlying data structures.

**Exploring and Analyzing Information with Process Analyzer**

Use the Process Analyzer Browser for exploring and analyzing information. With its intuitive and powerful graphic interface you can query, manipulate and analyze your data. Simple mouse clicks; combined with drag-and-drop functionality, provide easy access to:

- charts and spreadsheets
- various points of view in your information
- different levels of detail in the data

You can have more than one view opened simultaneously. All the information about a cube or view observed in the different components of Process Analyzer corresponds to the current view. Changing the current view updates the other components.

**Process Analyzer Browser Components**

Process Analyzer Browser components allow users to perform navigational and other operations in the current view. The components include:

- Process Analyzer Explorer
- Dimension Bar
- Analysis Pane
- Status Bar
- Toolbars and Menus
Navigating in the Process Analyzer Browser

You can navigate within the Process Analyzer Browser to display information that best meets your needs. You can use the Dimension Bar, or you can right-click on various elements in the analysis pane. You can use either method to quickly drill up and down through hierarchies of information to find the dimensions and measures you need.

You can also navigate by clicking on various elements in the graphic model displayed in the Analysis pane. Double-click or right-click on a series label or an item on the X-axis to drill up or down; or drag a Dimension list onto an axis to change dimensions.

Drilling Up/Down

As shown below, you can move up and down through the dimension hierarchies to view the information at different levels of detail. This is called drilling up and drilling down. You can also select measures to analyze and filter a query by determining which elements of remaining dimensions are not pertinent to the view you are developing. The results of your analysis operations are displayed as you perform them in the Analysis Pane, in the form of charts or tables. You can select the different types of charts (bars, pies, stacked bars, 3D, and so forth) and the tables using Menu Bar commands or directly from the toolbar.

Analysis Pane
About Cubes

Because they can display three or more dimensions of data, the objects of analysis for the Process Analyzer Browser are called cubes. Cubes are created through the retrieval of data from the Fuego Execution Engine for particular business processes.

Cubes are based on multidimensional data models. The main characteristic of the multidimensional model is its ability to represent information in a way that is intuitive for the user. This representation of information is similar to the vision the user has of the business. Cubes are multidimensional in the sense that more than just X and Y axis information can be displayed and manipulated.

Note: The design of the WorkloadFull and Process Performance cube structures has been predetermined and cannot be changed.

Given a model and the data collected from your business's transactional systems via the Fuego Execution Engine, Process Analyzer builds the corresponding cube for analysis using the Process Analyzer Browser. As new information is added to the transactional systems, periodic updates of cube information take place. These updates can be complete or incremental builds. Frequency of updates is dependent on the amount of new data and the frequency with which it is added to the transactional systems. The updates can be programmed by your system administrator to take place when work loads are low; for example, at night.

To analyze data, the user opens a cube with the Process Analyzer Browser. The Process Analyzer Browser's GUI allows you to display the information you want in a way that is easiest for you to analyze.

There are two multidimensional Fuego Process Analyzer data cubes:

WorkloadFull cube - The WorkloadFull cube is multidimensional because it allows analysis of dates and activities, and uses a measure of quantity of instances being processed for each activity shown.
**Example: WorkloadFull Cube - Quantity of Instances Being Processed as Measured by Date and Activity**

Process Performance Cube - This view of a process performance cube shows the number of instances that were successfully routed from an activity to any of the next ones. The view is multidimensional because it shows more than one activity on a series of dates.
Example: Process Performance Cube View Showing Number of Instances Successfully Routed from Activities
About Views

Given the structure of a cube, each view generates different views of the information in the cube. For example, if you are analyzing a WorkloadFull cube, the Process Analyzer Browser views may include the following:

- The average time instances remain in a particular activity before being routed to the next
- The average time it takes for an instance to complete a process
- The total number of instances being processed at a given moment for a particular process

Each of these queries constitutes a different view of the WorkloadFull cube. One of the main strengths of Process Analyzer is its potential for generating these and other views from a single cube, and then allowing you to use a simple graphical interface to examine the results.

When you navigate in process analyzer, you are really just changing the perspective of a particular cube to achieve different views. You can navigate using the:

- Process Analyzer explorer,
- Dimension bar, or
- Analysis pane

A view, then, is a specific location within the cube that defines the data being analyzed. Each cube has a default view that the user sees when initially accessing the cube. The user can subsequently generate a variety of views of the cube and save them for later analysis.

You determine a particular view by increasing or decreasing the level of detail of information in a dimension, or changing the current measure or dimensions in the axis.

As part of the query, you can move up and down through the dimension hierarchies to view the information at different levels of detail. This is called drilling up and drilling down.

You can save any cube view for later reference. This feature keeps you from having to repeat the same navigational steps each time you want the same view. Each time you open a saved view, the presentation of the data remains as you wished, but the data is updated.

**Note:** Views do not contain information. They are a reference to the cube with which they were generated and a location within the cube. This means that any update of information in the cube is automatically and immediately mirrored in the views generated from the cube.
Dimensions and Measures

Dimensions
The classifications or points of view of the information are dimensions of a cube. They make analysis possible. Through the combination of these dimensions in the Process Analyzer Browser, the user can generate several views of the same cube to serve a variety of analysis needs, such as by:

- Date and Process
- Date and Users
- Process and Roles
- Activities and Times
- Organizational Unit and Date

The cubes include the ability to order each dimension in a hierarchy. This allows users to analyze information for a specific dimension, at varying levels of detail. For example: a date hierarchy can include years, quarters, months and days; and process may include org units and activities. Users can then analyze information in a single cube by years, quarters, months, org units, activities, and so forth.

Measures
Measures are the elements a user quantifies within a cube. Measures are the values to be analyzed, classified from the different perspectives that the dimensions offer. The measures represent business indicators the cube analyzes and thus allow the user to measure and determine business trends. Users can filter each measure by different dimensions to obtain the desired view of data. Measures may contain information such as work, average time per activity or the total number of instances processed by a specific process (process throughput).

Combined Analysis of Dimensions and Measures
Thus, the model's functionality (and ultimately the cubes) make queries possible for any combination of the dimensions and measures, at different levels of detail for the dimensions. For example, you could begin with an analysis verifying increased efficiency of process throughput over the last three months. If one month has a low value, the user can query by drilling down into the various activities and roles and even individuals in the process. If the reduction of average time per instance is a result of a smaller number of instances being processed, you could determine if this trend was attributable to a particular activity or lack of productivity.

The view you see in your Process Analyzer browser is formed by the X and Y axes. Charts generally have an X axis and a Y axis. The Y axis is typically used as the series axis on charts. Monoseries charts have only the Series axis but you can view the elements of the X axis. In spreadsheets, rows and columns correspond to the X and Y axes. The first step in specifying a query is determining which dimension is viewed on which axis.
Getting Started

Overview: Process Analyzer Browser Execution Modes

Depending on the environment you want to work in, Process Analyzer Browser executes in one of two modes:

- standalone
- client/server

Regardless of which execution mode you choose, the interface and available functionality of the Process Analyzer Browser remains the same.

Standalone Execution Mode

In standalone mode, cubes or views are processed locally at the client. If you have a copy of the cube on your hard drive, it means that all queries are resolved locally in the Process Analyzer Browser with no requirements for a Process Analyzer Server.

This execution mode is ideal for mobile users or any users working off-line, however, it may be inadequate if you are working with large cubes or cubes that are updated frequently.

Client/Server Execution Mode

In client/server mode, the Process Analyzer Browser works with the Process Analyzer Server, which processes and solves all queries made from the Process Analyzer Browser.

Each time you make a query (perform any navigational operation on the cube), the query is sent to the Process Analyzer Server, resolved, and the results are returned for display in the Process Analyzer Browser. This means that after starting the Process Analyzer Browser, you must use the Open command to connect to the Process Analyzer Server.

This execution mode is effective when several users are accessing a set of cubes. It also allows the management of larger cubes.

In addition, this mode allows a system administrator to manage security for each cube through establishing user names and passwords.
Opening a Cube or View in Standalone Mode

Use the Open command to open a cube or view in standalone mode.

To open a cube or view
There are several ways to open a cube or view.

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.

2. From the File menu, chose Open. The Open Cube or View dialog box appears.

3. There are several ways to open a cube or view:
   - Type a cube or view pathname.
   - Click on the drop-down list arrow. A list of recently opened cubes and views appears. Choose a cube or view from the list.
   - Choose Browse. The following Open Cube or View dialog box appears. Choose a drive, folder and cube or view. Click Open.

You return to the previous Open Cube or View dialog box.
Notes:

When opening a view, you must have access to the cube from which the view was generated. If you change a cube's location you cannot see the view. If the cube was assigned a password when it was built, you are prompted for the password when you open the cube or a view generated from the cube.

Opening a Cube or View in Client / Server Mode

Use the Open command to open a cube or view in client/server mode.

To open a cube or view in client/server mode

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.

2. From the File menu, chose Open. The Open Cube or View dialog box appears.

3. There are two ways to open a cube or view:
   - Type a URL for the cube or view. (See the following procedure for the format.)
   - Click on the drop-down list arrow. A list of recently opened cubes and views appears. Choose a URL for a cube or view from the list.
To specify the correct URL address

1. Specify the server and cube or view you are accessing through a URL in the following format:

   \texttt{otp://<server>/<cube\_name or view\_name> \{username:password\}}

   where:

   \texttt{<server>} is the name or IP address of the machine where Process Analyzer Server is executing;

   \texttt{<cube\_name>} is the name assigned to the cube by the Process Analyzer administrator;

   \texttt{<view\_name>} is the name of the saved view; and

   \texttt{\{username:password\}} is the user name and password for access to the Process Analyzer Server. You must include a space between the cube or view name and the user name. Inclusion of the user name and password is optional. Some sample formats:

   \texttt{otp://my\_server/Sales}

   \texttt{otp://my\_server/Sales User1:JSmith03}

   \texttt{otp://my\_server/Sales/Sales\_By\_Client}

2. You can also select a URL for the cube or view by choosing the Reopen command from the File menu. This always creates a new window. The submenu for this command contains a list of the 10 most recently opened files.

Notes:

1. In client/server mode, the Process Analyzer Server processes the cube and any queries made on the cube.

2. To access a cube in client/server mode, the cube must be duplicated by the administrator. The administrator also controls access to dimensions, hierarchies within the dimensions, and the measures of the cube.

3. To publish cube views, users must have appropriate permissions. You can only publish views that have been generated from cubes defined for the server.

4. Users can only access views they have published to the server.
Opening a Cube or View through HTTP or FTP

Use the Open command to open a cube or view using HTTP or FTP.

To open a cube or view using HTTP or FTP

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.
2. From the File menu, choose Open. The Open Cube or View dialog box appears.

3. There are two ways to open a cube or view:
   - Type a URL for the cube or view.
   - Click on the drop-down list arrow. A list of recently opened cubes and views appears. Choose a URL for a cube or view from the list.

To Specify the Correct URL

1. Specify the Web server and cube you are accessing through HTTP in the following format:
   
   http://<Web_server>/<path>/<cube_name>.cube
   
   or
   
   http://<Web_server>/<path>/<view_name>.view

   or specify the FTP server and view you are accessing through FTP in the following format:

   ftp://<ftp_server>/<path>/<cube_name>.cube {username:password}
   
   or
   
   ftp://<ftp_server>/<path>/<view_name>.view {username:password}

   where:

   <Web_server> or <ftp_server> is the name or IP address of the Web or FTP server
   
   <cube_name> is the name assigned to the cube by the Process Analyzer administrator
   
   <view_name> is the name of the saved view; and

   {username:password} is the user name and password for access to the Process Analyzer Server. You must include a space between the cube or view name and the user name. Inclusion of the user name and password is optional. Some sample formats:

   http://www.my_business.com/cubes/sales.cube
http://www.my_business.com/cubes/sales.view
User1:JSmith03

2. You can also select a URL for the cube or view by choosing the Reopen command from the File menu. This always creates a new window. The submenu for this command contains a list of the 10 most recently opened files.

Notes:
To access a cube or through HTTP or FTP, files must be previously published by the Web site or FTP administrator.

When you access a cube or view through HTTP or FTP, Process Analyzer Browser is operating in standalone mode. This means that the complete cube is transferred to the client machine. This may be an issue if the cube is large or if you are accessing it from the applet through the Internet or through a dial-up line of low transfer capacity. Client/server mode may be more appropriate.

When you open a view, the cube also opens. This means you must also have access to the cube. If the view was generated from a cube accessed through HTTP, when the view opens the URL for the cube must be accessible. If the view was generated from a cube on an Process Analyzer Server, you must have access to the Process Analyzer Server.

If you are executing Process Analyzer Browser as an applet, you must use HTTP to access cubes or views. For security reasons, you cannot use FTP.

To open a cube or view automatically when you start Process Analyzer Browser, include the cube or view pathname as a parameter.
Opening a Cube or View in a New Window

To Open a Cube or View in a New Window

1. To open the cube or view in a new window, select the Create new window check box.

   **Note:** If you want to replace a current cube or view clear the Create new window check box.

2. Click open. The cube or view opens.

3. From the File menu, chose Reopen. The submenu for this command contains a list of the 10 most recently opened files. This always creates a new window.
Opening a Cube or View Automatically

To open a cube or view automatically when you start Process Analyzer Browser

To open a cube or view automatically when you start Process Analyzer Browser, you must include the cube or view pathname as a parameter.

In Windows from the Run command or from an MS-DOS prompt:

1. Type:
   
   `Browser.exe <path>/<cube_name>`

   From the command line for other platforms:

2. Type:
   
   `Browser.sh <path>/<cube_name>`

   Example:

   `Browser.sh /usr/local/cubes/sales.cube`

Using the Menu Bar and Toolbar

Menu Bar

The Menu Bar activates Process Analyzer's functions and operations.

File Menu

<table>
<thead>
<tr>
<th>Command/Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Ctrl+O</td>
<td>Open a cube or a cube view.</td>
</tr>
<tr>
<td>Reopen</td>
<td>Open a recently used cube or view</td>
</tr>
<tr>
<td>Save View</td>
<td>Save the current cube view to the current view name.</td>
</tr>
<tr>
<td>Save View As</td>
<td>Save the current cube view to a new view name.</td>
</tr>
<tr>
<td>Properties</td>
<td>Display or update the cube or cube view properties.</td>
</tr>
<tr>
<td>Close Ctrl+C</td>
<td>Close the current cube or cube view.</td>
</tr>
<tr>
<td>Export</td>
<td>Export the current cube view as a GIF format graphic file.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Enter header and footer text for printing.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Display a print preview.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the current cube view.</td>
</tr>
<tr>
<td>Send to Report</td>
<td>Send the current display to Process Analyzer Report.</td>
</tr>
<tr>
<td>Exit Ctrl+X</td>
<td>Exit from Process Analyzer Browser.</td>
</tr>
</tbody>
</table>
### Edit Menu

<table>
<thead>
<tr>
<th>Command/Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Undo the previous command.</td>
</tr>
<tr>
<td>Redo</td>
<td>Redo the previous command.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy spreadsheet data.</td>
</tr>
</tbody>
</table>

### View Menu

<table>
<thead>
<tr>
<th>Command/Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Explorer</td>
<td>Turn display of the Process Analyzer Explorer pane on or off.</td>
</tr>
<tr>
<td>Show Spreadsheet</td>
<td>Display information in a spreadsheet.</td>
</tr>
<tr>
<td>Display Values</td>
<td>Turn the display of values on charts and grids on or off.</td>
</tr>
<tr>
<td>Grouped Bars</td>
<td>Select Grouped Bars as the active chart or grid type.</td>
</tr>
<tr>
<td>Stacking Bars</td>
<td>Select Stacking Bars as the active chart or grid type.</td>
</tr>
<tr>
<td>Monoseries Bars</td>
<td>Select Monoseries Bars as the active chart or grid type.</td>
</tr>
<tr>
<td>Pie</td>
<td>Select Pie as the active chart or grid type.</td>
</tr>
<tr>
<td>Plot</td>
<td>Select Plot as the active chart or grid type.</td>
</tr>
<tr>
<td>Scatter Plot</td>
<td>Select Scatter Plot as the active chart or grid type.</td>
</tr>
<tr>
<td>3D Grouped Bars</td>
<td>Select 3D Grouped Bars as the active chart or grid type.</td>
</tr>
<tr>
<td>3D Stacking Bars</td>
<td>Select 3D Stacking Bars as the active chart or grid type.</td>
</tr>
<tr>
<td>3D Monoseries Bars</td>
<td>Select 3D Monoseries Bars as the active chart or grid type.</td>
</tr>
<tr>
<td>3D Pie</td>
<td>Select 3D Pie as the active chart or grid type.</td>
</tr>
<tr>
<td>Real 3D</td>
<td>Select bars, pyramids or tape as the true 3-dimensional chart type.</td>
</tr>
<tr>
<td>Two Measures</td>
<td>Display the graph or chart using two measures.</td>
</tr>
<tr>
<td>Invert Axis</td>
<td>Exchange the X-axis and the Y axis.</td>
</tr>
<tr>
<td>Show Grid</td>
<td>Turn display of a grid behind charts on or off.</td>
</tr>
</tbody>
</table>
### Explore Menu

<table>
<thead>
<tr>
<th>Command/Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial View</td>
<td>Return to the initial view.</td>
</tr>
<tr>
<td>Top Query</td>
<td>Display the browser's original view.</td>
</tr>
<tr>
<td>Display Values</td>
<td>Turn the display of values in charts or spreadsheets on or off.</td>
</tr>
<tr>
<td>Display Zeros</td>
<td>Turn the display of zero values in charts or spreadsheets on or off.</td>
</tr>
<tr>
<td>Ranking</td>
<td>Customize the order of appearance of the bars of a chart, or the values of a grid.</td>
</tr>
<tr>
<td>Hide/Show</td>
<td>Select the categories or data elements to hide or show.</td>
</tr>
<tr>
<td>Add Calculated Row/Column</td>
<td>Add a calculated row or column to a spreadsheet.</td>
</tr>
<tr>
<td>Display Totals - X</td>
<td>Turn the display of totals for the X-axis on or off.</td>
</tr>
<tr>
<td>Display Totals - Series</td>
<td>Turn the display of totals for the Series on or off.</td>
</tr>
<tr>
<td>Display Percentages - X</td>
<td>Turn the display of percentages for the X-axis on or off.</td>
</tr>
<tr>
<td>Display Percentages - Series</td>
<td>Turn the display of percentages for the Series on or off.</td>
</tr>
<tr>
<td>Swap Axis</td>
<td>Exchange the X-axis dimension and the Series dimension.</td>
</tr>
</tbody>
</table>

### Tools

<table>
<thead>
<tr>
<th>Command/Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Bookmark</td>
<td>Save an Organizer view and define it as a bookmark.</td>
</tr>
<tr>
<td>New Rule</td>
<td>Define a rule.</td>
</tr>
<tr>
<td>Go to Rule</td>
<td>Go to the view with the current rule.</td>
</tr>
<tr>
<td>Save Rule</td>
<td>Save the current view and rule.</td>
</tr>
<tr>
<td>Send Rule to Server</td>
<td>Send the current view and rule to the Process Analyzer Server.</td>
</tr>
<tr>
<td>Options</td>
<td>Add, edit, delete user-defined functions, spreadsheet formatting, and spreadsheet styles.</td>
</tr>
</tbody>
</table>
### Window Menu

<table>
<thead>
<tr>
<th>Command/Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Bookmark</td>
<td>Save an Organizer view and define it as a bookmark.</td>
</tr>
<tr>
<td>New Rule</td>
<td>Define a rule.</td>
</tr>
<tr>
<td>Go to Rule</td>
<td>Go to the view with the current rule.</td>
</tr>
<tr>
<td>Save Rule</td>
<td>Save the current view and rule.</td>
</tr>
<tr>
<td>Send Rule to Server</td>
<td>Send the current view and rule to the Process Analyzer Server.</td>
</tr>
<tr>
<td>Options</td>
<td>Add, edit, delete user-defined functions, spreadsheet formatting, and spreadsheet styles.</td>
</tr>
</tbody>
</table>

### Look and Feel

<table>
<thead>
<tr>
<th>Command/Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Bookmark</td>
<td>Save an Organizer view and define it as a bookmark.</td>
</tr>
<tr>
<td>New Rule</td>
<td>Define a rule.</td>
</tr>
<tr>
<td>Go to Rule</td>
<td>Go to the view with the current rule.</td>
</tr>
<tr>
<td>Save Rule</td>
<td>Save the current view and rule.</td>
</tr>
<tr>
<td>Send Rule to Server</td>
<td>Send the current view and rule to the Process Analyzer Server.</td>
</tr>
<tr>
<td>Options</td>
<td>Add, edit, delete user-defined functions, spreadsheet formatting, and spreadsheet styles.</td>
</tr>
</tbody>
</table>

### Help

<table>
<thead>
<tr>
<th>Command/Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>Display Help for Process Analyzer Browser.</td>
</tr>
<tr>
<td>About Process Analyzer Browser</td>
<td>Display version information about Process Analyzer Browser.</td>
</tr>
</tbody>
</table>
# Toolbar

The Process Analyzer Toolbar acts as a time-saver, providing shortcuts to the most frequently used functions and operations.

## Toolbar Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Open a cube or a view of a cube.</td>
</tr>
<tr>
<td>Save View</td>
<td>Save the current cube view to the current view name.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the current cube view.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy spreadsheet data.</td>
</tr>
<tr>
<td>Undo</td>
<td>Undo previous command.</td>
</tr>
<tr>
<td>Redo</td>
<td>Redo previous command.</td>
</tr>
<tr>
<td>Show Explorer</td>
<td>Turn display of the Process Analyzer Explorer pane on or off.</td>
</tr>
<tr>
<td>Initial View</td>
<td>Return to the initial view.</td>
</tr>
<tr>
<td>Top Query</td>
<td>Display the browser's original view.</td>
</tr>
<tr>
<td>Ranking</td>
<td>Customize the order of appearance of the bars of a chart, or the values of a grid.</td>
</tr>
<tr>
<td>Hide/Show</td>
<td>Select the categories or data elements to hide or show.</td>
</tr>
<tr>
<td>Swap Axis</td>
<td>Exchange the X-axis dimension and the Series dimension.</td>
</tr>
<tr>
<td>New Rule</td>
<td>Define a rule.</td>
</tr>
<tr>
<td>Go to Rule</td>
<td>Go to the view with the current rule.</td>
</tr>
<tr>
<td>Show Spreadsheet</td>
<td>Display information in a spreadsheet.</td>
</tr>
<tr>
<td>Plot</td>
<td>Select Plot as the active chart or grid type.</td>
</tr>
<tr>
<td>Scatter Plot</td>
<td>Select Scatter Plot as the active chart or grid type.</td>
</tr>
<tr>
<td>3D Grouped Bars</td>
<td>Select 3D Grouped Bars as the active chart or grid type.</td>
</tr>
</tbody>
</table>
### Toolbar Commands (contd.)

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="icon" /> 3D Stacking Bars</td>
<td>Select 3D Stacking Bars as the active chart or grid type.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /> 3D Monoseries Bars</td>
<td>Select 3D Monoseries Bars as the active chart or grid type.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /> 3D Pie</td>
<td>Select 3D Pie as the active chart or grid type.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /> Bars</td>
<td>Select Real 3D Bars as the active chart or grid type.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /> Pyramids</td>
<td>Select Real 3D Pyramids as the active chart or grid type.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /> Tape</td>
<td>Select Real 3D Tape as the active chart or grid type.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /> Two Measures</td>
<td>Turn the two measures mode on or off.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /> Invert Axis</td>
<td>Exchange the X-axis and the Y-axis.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /> Show Grid</td>
<td>Turn display of a grid behind charts on or off.</td>
</tr>
</tbody>
</table>

---

## Using the Dimension Bar and Measures List

### Dimension Bar

The Dimension Bar contains the measures and dimensions that define a cube. Each dimension has a corresponding drop-down list. Use the Dimension bar to navigate through a cube by:

- changing or adding dimensions to an axis
- increasing or decreasing the level of detail for a dimension
- filtering through dimensions not on an axis
- changing the selected measure

The lists on the Dimension Bar represent all of the analytical possibilities offered by a cube for the measures shown in the measures drop down list.

---

**Dimension Bar**

![Dimension Bar Image](image)

When you display a particular dimension list, you can drill down to access the next level down from the currently selected level, or you can move within the same level to a sibling category. You can also drill up by selecting an ancestor of the category. You can also drill directly to the top level of a dimension. Different fonts and font
colors distinguish the current element, its children, sibling elements, and its ancestral elements.

**Drilling Down Using Dimension Bar**

![Process Analyzer User Guide](image1)

The arrows to the left of the category or element label in the Dimension list indicate the drilling possibilities of that level: up, down, or up/down. This convention also applies to the Process Analyzer Explorer icons.

If other elements exist at the same level as the currently queried element, small up/down arrows (spin box) appear to the right of the list. Use the up and down arrows of the spin box to rotate through the elements at that level.

When you perform one of these operations on a dimension not currently on an axis, you are in effect applying a filter to a query. This causes the name of the dimension, or the element currently queried within the hierarchy, to appear.

**Note:** Depending on the number of dimensions defined in the cube, the Dimension bar may occupy more than one row in your Process Analyzer browser.
Measures List

The measures list is located in the Dimension Bar with the dimension lists, but it is denoted by a small ruler. It lists all the measures available for the cube being displayed. Use it to select the measure to analyze. When you access a view with a two measures chart, the Dimension bar appears a second measure.

Using Process Analyzer Explorer

The Process Analyzer Explorer provides a general overview of the different dimensions forming the model being analyzed and its corresponding hierarchies. It includes a complete view of the cube and its dimensions, hierarchies and measures.

This allows the user to quickly discover the drilling options or level of detail available for each dimension. The Process Analyzer Explorer provides centralized access to all the functions necessary for model analysis.

Through the Process Analyzer Explorer you can set the X-axis and Series dimensions, determine the measures, filter the analysis through any given category or element, and drill up or down.

To achieve this functionality and make use of its navigational power, the model appears in a tree structure. Branches represent each dimension of the model and the measures. Sub-trees specify the hierarchies of the dimension. Branches within the sub-tree represent the data elements, that is, the basis on which each dimension is formed.
**Process Analyzer Explorer Pane**

- Date (X)
  - Date
  - Last 12 Months
  - Year-to-date
  - Previous Month
  - Current Month
  - Rotating 12-month years
- Products (Series)
  - Mountain Bikes
    - Professionals
    - Competition
    - Enthusiastic
    - Recreation
  - Route Bikes
- Customers
- Vendors
- Location
- Measures
  - Sold Units
  - Gross Amount
  - Discount
  - Net Amount
  - Comissions
  - Cost
  - Profit %

**Tip:** You can use the Process Analyzer Explorer to familiarize yourself with the different hierarchies within a model, without actually having to navigate through it. It is an ideal starting point for working with an unfamiliar cube. Use the query options, levels of detail and available measures to become familiar with the cube contents. Displaying the Process Analyzer Explorer pane is optional, you can show or hide it using the Explorer command on the menu bar or toolbar.
**Note:** The colors and font types of the dimension labels, categories and elements vary according to the model's current view. They identify dimensions located on the axis, the current element within each dimension, the current measure, and dimensions where elements are selected but not currently visible in the tree view.

The Process Analyzer Explorer also provides centralized access to all navigational operations. Using drag-and-drop or right-click functionality, you can:

- change or add dimensions in the axis
- increase or decrease the level of detail in the hierarchies
- change the selected measure

*Process Analyzer Explorer Right-Click Shortcut Menu Example*
Saving a Cube View

Use the Save View or Save View As commands to save a cube view.

You can save:

- a new view from a cube
- a new view from the current view
- the current view

If you are in client/server mode, you can also save the view to the Process Analyzer Server.

To save a view

1. From the File menu choose Save View. The Save View as... dialog box appears.

2. Choose Save.

To save a new view

1. From the File menu choose Save View As. The Save View as... dialog box appears.

2. There are several ways to save a new view:
   - Type the folder and view name
   - Type an URL for the Process Analyzer Server
   - Click on the drop-down list arrow. A list of recently opened views appears. Choose a view filename or URL from the list. Choose Browse. The following Open Cube or View dialog box appears.
3. Select a drive, folder and view. Click Open. You return to the **Save View as...** dialog box. The name of the view filename or URL is displayed in the Connect to a Server or select a file box.

4. Choose **Save**. The view is saved and you are returned to the Process Analyzer Browser analysis pane.

To save a view to the Process Analyzer server (client/server mode only)

1. From the File menu choose Save View As. The **Save View as...** dialog box appears.

2. Type the server, cube and view in the following format:
   
   `otp://<server>/<cube_name>/<view_name>`

   Where:
   
   `<server>` is the name or IP address of the machine where Process Analyzer Server is executing
   <cube_name> is the name assigned to the cube by the Process Analyzer administrator and
   <view_name> is the name of the saved view.

   Example:

   `otp://my_server/Sales/Sales_By_Client`

**Notes:**

1. If a cube view is open, the view saves to that filename unless you first change the name in the **Save View as...** dialog box.

2. If you open a view, perform queries on the view and then choose Save, the current view overwrites the original view.
Creating a New View

Use the New View command to create a new view based on the current view. The
new view is identical to the original view when it is created but it is completely
independent of the original view. You can navigate the view, hide elements, add
calculated elements, and so forth, without affecting the original view.

To create a new view
From the File menu, chose New View. A new window opens and becomes the current view.

To arrange additional view windows on your screen
From the Windows menu, choose Cascade, Horizontal and Vertical according to your
preference.

To view a specific window
From the Windows menu, choose either Next or Previous to view the next or
previous window or select a view from the list of available view windows.

Note: The original view becomes {cube name} [1]. Subsequent windows for synchronized
views or new views are numbered sequentially. For example, if you create three
synchronized views they are [2] through [4]. Closing a view automatically
renumbers all remaining views.

Bookmarking a View

Use the Bookmark command to save a view and define a bookmark in the Process
Analyzer Organizer.

To bookmark a cube or view:

1. From the Tools menu, choose New Bookmark. A dialog box appears asking you if you
want to replace the current view.

2. Click Yes. The O3 Organizer opens and the Bookmark dialog box appears.
3. Type the bookmark name in the Name box.

4. Type a URL or a path and filename in the URL box or choose Browse to select a path and filename.

5. Choose OK. The view is saved. The bookmark list appears in the Process Analyzer Organizer.

6. To quit Process Analyzer Organizer, from the File menu choose Exit. You return to the Process Analyzer Browser Analysis Pane.

**Note:** Process Analyzer Organizer on-line help documentation is not yet developed. Refer to the Using O3 Organizer User Guide for more information.

### Creating a New Synchronized View

Use the New Synchronized View command to create a copy of the current view. The new view is a copy of the current view and is synchronized with it. This means that all settings such as order, elements, hidden elements, total appears, and so forth are the same and are synchronized with the current view. Any navigational operations on one view affect all other synchronized views, except that the selection of the chart type or spreadsheet in the Analysis Pane is independent in each view.

This feature is useful if you want to query and view a cube and then want to display the results simultaneously in two or more chart or spreadsheet formats.
To create a synchronized view

From the Windows menu choose New Synchronized View. A new view window appears. Here is an example of three synchronized views open at the same time.

To arrange the additional view windows on the screen.

From the Windows menu, choose Cascade, Horizontal or Vertical, according to your preference.

To view a specific synchronized view

From the Windows menu, choose Next or Previous to view the next or previous window, or select a view from the list of available view windows.

Note: The original view becomes {cube name} [1]. Subsequent windows for synchronized views or new views are numbered sequentially. For example, if you create three synchronized views they are [2] through [4]. Closing a view automatically renumbers all remaining views. Closing a view automatically renumbers all remaining views.
Closing a Cube or View
Use the Close command to close a cube or cube view.

To close a cube or cube view:
From the File menu, choose Close. The cube or cube view closes.

Changing the GUI Look and Feel
You can change the look and feel of your Process Analyzer graphical user interface (GUI) according to your preference.

If you are using a Windows platform, you can choose between:

- Metal
- Motif
- Windows - the default (Windows platform only)

To choose a look and feel for the Process Analyzer interface
From the Look & Feel menu choose Metal, Motif, or Windows. Your interface appearance will change.

Windows Look and Feel Interface
Metal Look and Feel Interface

Motif Look and Feel Interface
Displaying Cube and Cube View Properties

Cube properties are established when the cube is designed and created. Use the Properties command to display the properties of a cube or cube view.

To display properties:

1. From the File menu, choose the Properties command. The View Properties dialog box appears.
2. Click the General tab to display general properties.

Click the Summary tab to display summary information.

Choose OK. You return to the Process Analyzer Analysis Pane display.
## Cube and Cube View Property Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The object type appears; Cube or Cube View.</td>
</tr>
<tr>
<td>Location</td>
<td>The URL or directory pathname of cube or cube view appears.</td>
</tr>
<tr>
<td>Creation</td>
<td>The creation date of the cube or cube view appears.</td>
</tr>
<tr>
<td>Revision</td>
<td>The revision date of the cube or cube view appears. If the cube or cube view has not been revised, the revision date defaults to the creation date.</td>
</tr>
<tr>
<td>Modification</td>
<td>The modification date of the cube or cube view appears. If the cube or cube view has not been modified, the modification date defaults to the creation date.</td>
</tr>
<tr>
<td>Password</td>
<td>A checkmark indicates that the cube is password-restricted for the design process.</td>
</tr>
<tr>
<td>Theme</td>
<td>Company-designated information appears.</td>
</tr>
<tr>
<td>Organization</td>
<td>Company-designated information appears.</td>
</tr>
<tr>
<td>Author</td>
<td>Company-designated information appears.</td>
</tr>
<tr>
<td>Category</td>
<td>Company-designated information appears.</td>
</tr>
<tr>
<td>Keys</td>
<td>Company-designated information appears.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the cube or cube view.</td>
</tr>
</tbody>
</table>
Using the Process Performance Cube

Overview: Process Performance Cube

The process performance cube is a tool designed to allow you to analyze for a one moment in time how many instances are in a process. You can use this tool to determine how well a process is performing. Using this tool to give you a "snapshot" of the process as it is working allows you to quickly spot bottlenecks, disconnects or other problems in your process.

For example, you could open the process performance cube and then drill down in a process to the activity level. You could then choose the work measure to see the number of instances that have been processed at each activity. If one activity has a greater number of instances waiting to be processed than the others, you know you have a potential problem that needs looking into—you might need more individuals assigned to this activity, or you may need to simplify the activity. Similarly, you could choose to view the average wait time for each instance per activity—if the number of instances at a particular activity are low, but the average wait time is high, then that means you either need more personnel assigned to that activity, or you need to redesign your process to reduce the complexity of the tasks associated with that activity. You can also look at the entire process to determine how much overall time an instance is taking to travel through from beginning to end. If the average processing time is exceeding the limits you've set as a goal, it could indicate that you need to refine your process design, or split the process into two or more separate processes. Finally, you can look at the number of instances that have been successfully processed as of that moment in time, to see if this total is in line with your business requirements.

You can also choose to analyze a single activity to see how many instances have been processed by a particular role or individual to date. You can also compare the number of instances that have been processed by a particular activity for two or more processes.

The process performance cube offers you the following process performance measures:

- **Work** - This is the number or instances per activity. The number of instances that were successfully routed from a particular activity to any of the next ones.

- **Average Time Per Activity** - The average time an instance waits in an activity (or all activities in a process) before it is executed and routed to the next activity or activities.

- **Average Time Per Process** - Average time that an instance takes to go from the begin to the end activity in a process. This is the process average throughput time.

- **Process Completed** - Total number of instances that were processed by a specific process. This is process throughput.

You structure your analysis of the data collected in the process performance cube by using one or more of the following dimensions:

- **Date** - This can range from the year down to a particular day.

- **Process** - You can drill down from a process down to an organizational unit or an activity.
• **Roles** - You can choose to perform your analysis on one or more of the roles as defined in Fuego's Org Manager for the process.

• **Users** - These are the individuals assigned to roles in the process as configured in Org Manager.

For example, as you analyze the Process Performance Cube, you can create the following Process Analyzer Browser views:

• The total number of instances that have been successfully routed from the Review Order Activity in the Marine Supply Order Fill process to other activities in the Marine Supply Order Fill Process.

• The average time it takes Finance Clerk Mary Jones to successfully route instances from the Check Credit activity in the Marine Supply Order Fill process to other activities.

• The average amount of time it is taking for instances to travel through the Marine Supply Order Fill Process from beginning to end.

• The total number of instances that have been processed from beginning to end by the Marine Supply Order Fill Process.

Each of the above views represents a different query to the Process Performance cube. By varying the dimensions and measures, you can create an almost unlimited combination of views.
**Dimensions: Process Performance Cube**

<table>
<thead>
<tr>
<th>Process Performance Cube Dimensions</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Date activity or instance completed execution.</td>
</tr>
<tr>
<td>Process (Hierarchy)</td>
<td>Hierarchical filter that allows selection of Process (top level), Org unit (2nd level), Activity (3rd level).</td>
</tr>
<tr>
<td>Time</td>
<td>Time the activity or instance completed execution.</td>
</tr>
<tr>
<td>Roles</td>
<td>Real roles configured in Org Manager that are defined for the process being analyzed.</td>
</tr>
<tr>
<td>Users</td>
<td>Participants configured in Org Manager that are defined for the process being analyzed.</td>
</tr>
</tbody>
</table>

**Measures: Process Performance Cube**

<table>
<thead>
<tr>
<th>Process Performance Cube Measures</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work</td>
<td>Number of instances per activity. This means the number of instances that were successfully routed from this activity to any of the next ones.</td>
</tr>
<tr>
<td>Average Time Activity</td>
<td>Average activity execution time to successfully route an instance to any of the next activities.</td>
</tr>
<tr>
<td>Average Time Process</td>
<td>Average instance execution time or average time that an instance takes to go from the Begin to the End activity of a process. This is basically the process average throughput time.</td>
</tr>
<tr>
<td>Process Completed</td>
<td>Total number of instances that were processed by a specific process. This is process throughput.</td>
</tr>
</tbody>
</table>
Sample View: Number of Instances Per Activity

The screen shot below shows a view of a process performance cube. The view shows the total number of instances that have been successfully routed from a particular activity in the process for a given time period.

In the example shown, to date in March 2002, about 40 instances (in this case the instances equate to orders) have been successfully routed from the Review Order activity to other activities in the Marine Supply Order Fill Process.

To display a view showing the process performance cube work measure with the number of instances per activity:

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.
2. From the Process Analyzer Browser File menu, chose Open. The **Open Cube or View** dialog box appears. Navigate to the updated version of your process performance cube. Check the date and time to ensure that it has been recently updated.

![Open Cube or View dialog box](image)

Click **Open**.

3. A top-level view of your Organizational Unit Appears. In this case it is fuegotech.

![Top-level view of Organizational Unit](image)
4. Click on the drop-down arrow to the right of the Measures box in the Dimension Bar and select Work.

5. Right-click in the Process box to the right of the chart and choose Drill-down. Right click on the process you wish to analyze and choose Drill-down again. Repeat until you reach the activity level for a process. Your window should look similar to this:

6. Next select the date by double-clicking on the date label at the bottom of the chart. The current month should appear.
7. Next, change the bar chart from two-dimensional to three-dimensional. Click on the three-dimensional bar chart icon in the menu toolbar. Your view should now look something like this:

8. Rearrange the activities in the order that best serves your analysis. In our example, we want to make sure the Review Order activity is labeled and placed closest to the front, for easy viewing. Right click on the Review Order activity in the legend box to the right of the chart and select Move down. Repeat until the review order activity is displayed at the front. Your view should now appear similar to the example at the beginning of this topic.

9. Save the cube view.

**Sample View: Average Time Per Activity**

The screen shot below shows a view of a process performance cube. The view shows the average time an instance waits in an activity (or all activities in a process) before it is executed and routed to the next activity or activities.

The example below shows the average time it takes Finance Clerk Mary Jones to successfully route instances from the check credit activity in the Marine Supply Order fill process to other activities. The label in the graphic shows that in March it took Mary an average of 20 minutes and 28 to perform each credit check.

**Note:** This time includes the amount of time the item waited in Mary's queue before she actually performed the credit check.
To display a view showing the process performance cube average time per activity measure

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.

2. From the Process Analyzer Browser File menu, chose Open. The Open Cube or View dialog box appears. Navigate to the updated version of your process performance cube. Check the date and time to ensure that it has been recently updated.

3. Click Open.
4. A top-level view of your Organizational Unit Appears. In this example, it is fuegotech.

5. Click on the drop-down arrow to the right of the Measures box in the Dimension Bar and select Avg Time Activity.

6. Right-click in the Process box to the right of the chart and choose Drill-down. Right click on the process you wish to analyze and choose Drill-down again. Repeat until you reach the activity level for a process. Your window should look similar to this:
7. Click Process Analyzer Explorer on the toolbar to display the Process Analyzer Explorer pane. Expand the Roles hierarchy. Click on the finance clerk role and drag it to the process box. Your window should look similar to this:

8. Next select the date by right-clicking on the date label at the bottom of the chart and selecting drill-down. The current month should appear.

9. Add a value label in minutes and seconds by right-clicking on the single bar in the graph. Select Display Values. Your window should now look similar to the sample shown at the beginning of this topic. Save the cube view.
Sample View: Average Time Per Process

The screen shot below shows a view of a process performance cube. The view shows the average time an instance takes to go from the beginning to the end activity in a process. This is the process average throughput time.

The example below shows the average amount of time it is taking for instances to travel through the Marine Supply Order fill process from beginning to end. The data shown is the average throughput for each day there was activity for a week-long period.

Note: The Y axis measurement is set to seconds by default and cannot be changed.

To display a view showing the process performance cube average time per process measure

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.

2. From the Process Analyzer Browser File menu, chose Open. The Open Cube or View dialog box appears. Navigate to the updated version of your process performance cube. Check the date and time to ensure that it has been recently updated.
3. Click **Open**.

4. A top-level view of your Organizational Unit Appears. In this example, it is fuegotech.
5. Click on the drop-down arrow to the right of the Measures box in the Dimension Bar and select Avg Time Process.

![Image of chart with drop-down menu]

6. Right-click in the Process box to the right of the chart and choose Drill-Down. Right click on any processes you do not wish to analyze and select Hide All '{name of process}'.

7. Right-click on the numerical date at the bottom of the graph and select Drill Down repeatedly until you find the date range you want.

8. Add a value label in minutes and seconds by right-clicking on any of the bars in the graph. Select Display Values. Your window should now look similar to the sample shown at the beginning of this topic.

9. Save the cube view.

**Sample View: Process Completed**

The screen shot below shows a view of a process performance cube. The view shows the total number of instances that were processed by a specific process. This is process throughput.

The example below shows the total number of instances that have been processed from beginning to end by the Marine Supply Order Fill Process. The data shown is the process throughput for each day there was activity for a week-long period.

**Note:** The totals shown below are cumulative and begin accruing when the Process Performance cube is built the first time.
To display a view showing the process performance cube process completed measure

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.

2. From the Process Analyzer Browser File menu, chose Open. The Open Cube or View dialog box appears. Navigate to the updated version of your process performance cube. Check the date and time to ensure that it has been recently updated.

3. A top-level view of your Organizational Unit Appears. In this example, it is fuegotech.
4. Click on the drop-down arrow to the right of the Measures box in the Dimension Bar and select Process Completed.

5. Right-click in the Process box to the right of the chart and choose Drill-Down. Right click on any processes you do not wish to analyze and select Hide All '{name of process}'.

6. Right-click on the numerical date at the bottom of the graph and select Drill Down repeatedly until you find the date range you want.

7. Add value labels to the bars in the graph by right-clicking on any bar. Select Display Values. Your window should now look similar to the sample shown at the beginning of this topic.

8. Save the cube view.

Spreadsheet View: Number of Instances Processed Per Activity

The screen shot below shows a view of a process performance cube. This spreadsheet view shows the total number of instances that have been successfully routed from each activity in the process for a given time period.

In the example shown, if you locate the Review Order activity in the left hand column, you will see that the green total column at the far right indicates that 56 instances (in this case the instances equate to orders) have been successfully routed from the Review Order activity to other activities in the Marine Supply Order Fill Process to date in March 2002.
To display a spreadsheet view showing the process performance cube work measure with the number of instances per activity:

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.

2. From the Process Analyzer Browser File menu, chose Open. The Open Cube or View dialog box appears. Navigate to the updated version of your process performance cube. Check the date and time to ensure that it has been recently updated.

3. Click Open.
4. A top-level view of your Organizational Unit Appears. In this case it is fuegotech.

5. Click on the drop-down arrow to the right of the Measures box in the Dimension Bar and select Work.

6. Right-click in the Process box to the right of the chart and choose Drill-down. Right click on the process you wish to analyze and choose Drill-down again. Repeat until you reach the activity level for a process. Your window should look similar to this:
7. Select the date by double-clicking on the date label at the bottom of the chart. The current month should appear.

8. Select the spreadsheet view by clicking on the Spreadsheet Icon in the menu toolbar. Your view should now look something like this:
9. The next thing you can do is drill down on the date to show total for specific dates. Click on the drop-down arrow to the right of the Date dimension box and select the current month. (In this case, March.) The individual dates during which instances were processed during the month will be displayed as shown.

10. The last step is to add column and row totals. On the Explore menu choose Display Totals. Select Columns. Repeat and select Rows. Your view should now appear similar to the example at the beginning of this topic.

11. Save the cube view.
Sample View: User Performance Comparison

The screen shot below shows a view of a process performance cube. The view allows you to compare the performance of participants in a process.

The following example shows a list of all persons who have a role in the Marine Supply Order Fill process. Their performance metrics can be compared with each other. The first row, Work, shows the number of instances they have processed in March 2002 (to date). The second row, shows the average time each activity was in their queue before it was processed. (Note: This average time includes weekends and days off.) This view is a handy way to quickly identify bottlenecks or performance issues can be easily spotted.
To display a process performance view comparing user performance measures

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.

2. From the Process Analyzer Browser File menu, chose Open. The Open Cube or View dialog box appears. Navigate to the updated version of your Process Performance cube. Check the date and time to ensure that it has been recently updated.

3. Click Open. A top-level view of your Organizational Unit Appears. (fuegotech in this example.)
4. Select the spreadsheet view by clicking on the Spreadsheet Icon in the menu toolbar. Click on the Show Explorer icon in the menu toolbar. Your view should now look something like this:

- Click on Measures in the Explorer pane and drag it onto the Process column heading.
- Click on Users in the Explorer Pane and drag it next to the Date column heading in the spreadsheet pane.
- Select the date by expanding Date in the Explorer pane. Keep expanding until you find the appropriate time period, then highlight and drag on top of the numerical date column heading in the spreadsheet.
- Remove any unwanted rows or columns by right-clicking on the column or row heading and selecting Hide All ‘...’ Click on the Explore icon in the toolbar to close the Explore pane. Your window should now look similar to the sample shown at the beginning of this topic.
- Save the cube view.
Using the WorkloadFull Cube

Overview: WorkloadFull Cube

The Fuego WorkloadFull cube is a tool designed to allow you to analyze the amount of work completed during a period of time specified by you for a certain process. It shows the number of instances that completed the process for a given period of time. It also shows how much time on average it took an instance to complete each activity and the entire process. The value of this cube is that it enables you to determine the workload for a process at a particular moment in time—an hour, day, several days, a week, month, year or several years.

For example, you could perform a query using this cube to determine how many instances had been completed on a specific date (or range of dates) for a specific process. You could also determine the average time it took to process each instance from beginning to end. Additionally, the WorkloadFull cube can show how much time each activity consumed in processing the instance. Another feature of this cube allows you to list all participants in the process and then measure their individual performance against the three WorkloadFull cube performance measures.

The WorkloadFull cube offers you the following three process workload measures:

- **Task Wait Average** - Reports the average time instances remain in activities before being executed and routed to the next activity in the process flow.
- **Process Wait Average** - Average time instances have been running in the process.
- **Quantity** - Total number of instances in a given moment.

You structure your analysis of the data collected in the process performance cube by using one or more of the following dimensions:

- **Date** - Specify a date or range of dates
- **Process** - Select a specific process, organizational unit or activity
- **Origin** - Show the originating process of the activity or process you are analyzing
- **Waiting** - Display the activity that is waiting for the activity be completed
- **Roles** - You can chose to perform your analysis on one or more of the roles in the process as defined in Fuego’s Org manager for that process
- **Users** - You can chose to perform your analysis on one or more individuals assigned to one of the roles in the process

For example, as you analyze the WorkloadFull cube, you can create the following Process Analyzer Browser views:

- The average time per instance in March 2002 than an instance (order) waited in the Ship Order activity in the Marine Supply Order Fill Process before being processed (shipped).
- The cumulative average time required in March 2002 for instances to travel from the beginning to end activities in the Marine Supply Order Fill process.
- Total number of instances (that is, orders) processed by each activity in the Marine Supply Order Fill Process in March 2002.
A list of all users and their performance in March 2002 against the three WorkloadFull measures of Task Wait Average, Process Wait Average, and Quantity.

Each of the above views represents a different query to the WorkloadFull cube. By varying the dimensions and measures, you can create an almost unlimited combination of views.

A list of these dimensions and measures available for analyzing the WorkloadFull cube are listed below.

**Dimensions: WorkloadFull Cube**

<table>
<thead>
<tr>
<th>WorkloadFull Cube Dimensions</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Date that snapshot of business process captured.</td>
</tr>
<tr>
<td>Process (Hierarchy)</td>
<td>Hierarchical filter that allows selection of Process (top level), Org unit (2nd level), Activity (3rd level).</td>
</tr>
<tr>
<td>Origin</td>
<td>Only valid for subflow process activities; shows parent or originating process of activity being analyzed in child or subflow process.</td>
</tr>
<tr>
<td>Waiting</td>
<td>Shows the activity that is waiting for this process to complete.</td>
</tr>
<tr>
<td>Roles</td>
<td>Real roles configured in Org Manager that are defined for the process being analyzed.</td>
</tr>
<tr>
<td>Users</td>
<td>Participants configured in Org Manager that are defined for the process being analyzed.</td>
</tr>
<tr>
<td>Time</td>
<td>Time that snapshot of business process was captured.</td>
</tr>
</tbody>
</table>

**Measures: WorkloadFull Cube**

<table>
<thead>
<tr>
<th>WorkloadFull Cube Measures</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity Accumulator</td>
<td>Internal measure; for internal use only, not intended for end user to perform process analysis.</td>
</tr>
<tr>
<td>Task Wait Average</td>
<td>Reports the average time instances remain in an activity before being routed to the next activity in the process flow.</td>
</tr>
<tr>
<td>Process Wait Average</td>
<td>Cumulative time the instance has been running in the process. This is the instance average life time so far in the process (until the moment of taking the measure).</td>
</tr>
<tr>
<td>Snapshots</td>
<td>Total number of data versions generated into the Data Warehouse Database. This is the number of times the updater process migrated information from Fuego Execution Engines to the Data Warehouse database. The Snapshot dimension is for internal use only, it is not intended for the end user to perform process analysis.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Total number of instances in a given moment.</td>
</tr>
</tbody>
</table>
Sample View: Task Wait Average

The screen shot below shows a view of a WorkloadFull cube. The view shows the average time instances remain in activities before being executed and routed to the next activity in the process flow.

The following example shows the average time an instance (order) in the Marine Supply Order fill process waited at the Review Order activity before being processed (shipped).

Note: The Y axis measurement is set to seconds by default and cannot be changed.
To display a view showing the WorkloadFull cube task wait average measure

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.

2. From the Process Analyzer Browser File menu, chose Open. The Open Cube or View dialog box appears. Navigate to the updated version of your WorkloadFull cube. Check the date and time to ensure that it has been recently updated.

3. Click Open. A top-level view of your Organizational Unit Appears. (fuegotech in this example.)
4. Click on the drop-down arrow to the right of the Measures box in the Dimension Bar and select Task Wait Average.

5. Right-click in the Process box to the right of the chart and choose Drill-down. Right click on the process you wish to analyze and choose Drill-down again. Repeat until you reach the activity level for a process. Your window should look similar to this:

6. Next select the date by double-clicking on the date label at the bottom of the chart. The current month should appear. Double-click on the current month to display individual dates. Right click on those dates you do not want to display and select Hide All ‘...’
7. Next, hide all the activities listed in the Process legend box. Right click on each activity you do not wish to display and select Hide All '...' 

8. Add value labels to the bars in the graph by right-clicking on any bar. Select Display Values. Your window should now look similar to the sample shown at the beginning of this topic.

9. Save the cube view.

Sample View: Process Wait Average

The screen shot below shows a view of a WorkloadFull cube. The view shows the average time instances have been running in the process.

The following example shows the cumulative average time required in March 2002 for instances to travel from the beginning to end activities in the Marine Supply Order fill process.

![Sample View: Process Wait Average](image)

**Note:** The Y axis measurement is set to seconds by default and cannot be changed.

To display a view showing the WorkloadFull cube process wait average measure

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.
2. From the Process Analyzer Browser File menu, chose Open. The **Open Cube or View** dialog box appears. Navigate to the updated version of your WorkloadFull cube. Check the date and time to ensure that it has been recently updated.

![Open Cube or View dialog box](image)

3. Click **Open**. A top-level view of your Organizational Unit Appears. (fuegotech in this example.)

![Top-level view](image)
4. Click on the drop-down arrow to the right of the Measures box in the Dimension Bar and select Process Wait Average.
5. Right-click in the Process box to the right of the chart on the top-level organization (fuegotech in this example) and choose Drill-down. If there are other processes listed other than the one you which to analyze, right-click on each one of these and select Hide All ‘...' until only the process you wish to analyze is still listed. Your window should look similar to this:

6. Next select the date by double-clicking on the numerical date at the bottom of the chart. The current month should appear. Double-click on the current month to display individual dates. Right click on those dates you do not want to display and select Hide All ‘....'

7. Add value labels to the bar in the graph by right-clicking on it. Select Display Values. Your window should now look similar to the sample shown at the beginning of this topic.

8. Save the cube view.
Sample View: Quantity

The screen shot below shows a view of a WorkloadFull cube. The view shows the total number of instances in the process as of the last update of the WorkloadFull Cube.

**Note:** Update intervals for the Process Analyzer cubes are set in the Fuego Execution Console with the Run Updater utility. Check with your system administrator to determine the update intervals for your cubes.

The following example shows the total number of instances (which in this process are the equivalent of orders) being processed by each activity in the Marine Supply Order fill process for specific dates.

![Graph showing a view of a WorkloadFull cube](image)

**To display a view showing the WorkloadFull cube Quantity measure**

1. Start the Process Analyzer Browser from the Start Menu or by double-clicking on the Process Analyzer Browser icon on your desktop.
2. From the Process Analyzer Browser File menu, chose Open. The Open Cube or View dialog box appears. Navigate to the updated version of your WorkloadFull cube. Check the date and time to ensure that it has been recently updated.
3. Click **Open**. A top-level view of your Organizational Unit Appears. (fuegotech in this example.)
4. Click on the drop-down arrow to the right of the Measures box in the Dimension Bar and select Process Wait Average.
5. Right-click in the Process box to the right of the chart and choose Drill-down. Right-click on the process you wish to analyze and choose Drill-down again. Repeat until you reach the activity level for a process. Your window should look similar to this:

![Process Analyzer User Guide Image]

6. Next select the date by double-clicking on the numerical date at the bottom of the chart. The current month should appear. Double-click on the current month to display individual dates. Hide dates you do not want to display by right-clicking on each and selecting Hide All ‘...’ in turn for each.

7. You can rearrange the order of the activities as they appear left to right on the graph by right-clicking on each activity in the Process: box and then selecting move Up or move Down as appropriate. Your window should now look similar to the sample shown at the beginning of this topic.

8. Save the cube view.
Printing

Setting Up the Page

Use Page Setup to add header and footer text to pages.

To set up the page:

1. From the File menu, choose Page Setup. The Page Setup dialog box appears.
2. Type the header and footer text.
3. Click OK.

Previewing the Print

Use Print Preview to preview an analysis pane before printing it.

To preview and print

From the File menu, choose Print Preview. The Preview dialog box appears with the preview of the print.
To print the preview, choose Print. You return to the Process Analyzer desktop and the analysis pane prints. To cancel the print, choose Cancel. You return to the Process Analyzer desktop.

**Printing the Analysis Pane**

Use Print to print the current analysis pane.

**To print the analysis pane**

1. From the File menu, choose Print. The Print dialog box appears.
2. Complete the fields.
3. Choose OK. The analysis pane prints and you are returned to the Process Analyzer desktop.
Glossary

Activity
A manual or automated piece of work that forms one logical step within a process. A manual activity requires end user intervention, whereas an automatic activity can be completed automatically by the Execution Engine.

Analysis Pane
This is the interactive area where charts and grids are displayed.

Business Service
A set of one or more linked transactions (may be in the form of procedures or activities or services) which collectively realize a business objective or policy goal.

Current View
The view showing in the Analysis pane at a given time or the latest results of an analysis task. The current view of a model is defined by the dimension selections for the X-axis and Series dimensions, and the measure of the Y-axis. In addition, you can apply a filter on any of the dimensions. You can also display the information in the form of different charts (bars, stacked bars, pies, etc.) or grids, or save a view reached through a series of analysis operations for later consultation.

Data Element
The atom-like member of a category, at the lowest level of the hierarchy.

Descendant
Any category one level down in the hierarchy. A descendant may, in turn, have its own descendants.

Dimension
A consolidation of categories, all of which are of a similar type in the user's perception of the data. These categories, which are organized in hierarchies, relate to major aspects of a business, e.g. products, sales, and clients. Dimensions offer a very concise, intuitive way of organizing and selecting data for retrieval, exploration and analysis.

Dimension Bar
The dimension bar displays the dimensions that constitute a model. Navigate through the hierarchies of each dimension, or use drag-and-drop functionality to change the dimensions set as X or as Series.

Dimension Lists
The dimension lists are the main components of the Dimension bar. For each dimension in the model, a dimension list displays. The list contains the categories of a dimension, and you can open each list to display the hierarchical organization of the dimension.

Drilling Up/Down
Drilling up or down is a specific analytical operation whereby the user navigates among various levels of data ranging from the most consolidated
(up) to the most detailed (down). Drilling provides the opportunity to analyze data at many different levels of detail, thus changing the viewer’s perspective. For example, when viewing data corresponding to the Date dimension, you can drill down to see the data by quarters, months, or even weeks.

**Filter**

Filtering removes unnecessary information from a view, allowing you to focus on relevant data only. It is applied to the current view, with no implications for future analysis.

**Fuego product suite**

Suite of software products that enable business analysts to design, implement, analyze, and deliver a business process and then enable the end user to process instances that flow through the business process. Applications included in the suite include Process Designer, Org Manager, Process Analyzer, Work Portal, Execution Console, Execution Engine, COM Bridge, Component Manager and CIL Editor.

**Grid**

An analysis pane display selection, in which data is shown in tabular form.

**Hierarchical Relationships**

Any dimension’s members may be organized based on parent-child relationships. Typically, a parent member represents the consolidation of the members, which are its children. As a result, the parent/child relationships are hierarchical relationships. These hierarchies allow the analysis of information in different levels of detail.

**Instance**

A single enactment of the process. Instances are generally triggered by an event such as a customer order. Instances are processed in the Work Portal or automatically by the Execution Engine, depending upon your process design.

**Label**

The name given to a category.

**LDAP**

(Lightweight Directory Access Protocol) Standard Internet directory access protocol used to define directory services. These services provide demographic data over the network, including names, phone numbers, e-mail addresses and access control information. Most networks have at least one directory service, more likely two or three. LDAP replaces all the directory services with a standard protocol that allows the organization to centrally manage network assets.

**Lightweight Directory Access Protocol (LDAP)**

Standard Internet directory access protocol used to define directory services. These services provide demographic data over the network, including names, phone numbers, e-mail addresses and access control information. Most networks have at least one directory service, more likely two or three. LDAP
replaces all the directory services with a standard protocol that allows the organization to centrally manage network assets.

**Measure**

Measures are the numerical values by which the performance of a business is gauged.

**Measures List**

The measures drop-down list, which is always at the right end of the Dimension Bar, is where all the measures of a model are contained. Use the Measures list to select a measure for the current view.

**Multidimensional Analysis**

The objective of multi-dimensional analysis is to provide end-users with clear insight into the meaning contained in databases. The multi-dimensional approach to analysis aligns the data in a model with the analyst's mental representation of this data, thus reducing confusion and decreasing the chance of erroneous interpretations. It also eases navigation through the database by allowing you to search for a particular data element, ask for the data in a particular arrangement and define the analytical calculations. This innovative combination of simplicity and speed is one of the key benefits of multi-dimensional analysis.

**Multidimensional Model**

A model that contains a certain amount of data, arranged in dimensions to provide navigation with fast retrieval and drilling.

**Navigation**

Navigation describes the processes employed by users to explore a Cube interactively by drilling or rotating, usually using the Process Analyzer Browser.

**Org Manager**

A tool used to define and store LDAP Organization roles. The Org Manager tool also provides mapping between LDAP objects for implementation purposes.

**Organizational Role**

A role performed by a person or application. Organization Roles (sometimes referred to as real roles) are defined in the Org Manager tool. In Process Designer, abstract roles are matched to the Organization Roles before publishing and deploying a process.

**Process Designer**

Fuego module used to define roles, activities, transitions between activities, and the script behind the activities to create a total end-to-end business process design.

**Ranking**

Ranking is a Process Analyzer function which offers the ability to customize the order of the data displayed on a chart.
Role
Defines a common job function for work being performed in a process. See also Organizational Role.

Series
The third component of a chart, located on the left hand of the analysis pane.

Sibling
Siblings are two or more members of a hierarchy at the same level within the hierarchy, that is, when they have the same number of ancestors leading to the top.

Top Query
A function that allows the user to return to the model's original view.

Work Portal
A browser or desktop-based interface that displays instances that have been assigned to a specific user in a task list. The user launches the tasks and automatically routes them to appropriate persons or departments once they have been completed and sent out. Once a task is completed and sent, the Execution Engine automatically routes the instance to the user or system responsible for the next step in the process.

X-axis
The horizontal axis of a chart.

Y-axis
The vertical axis of a chart.

Process Analyzer Explorer
The Process Analyzer Explorer is a component that enables you to explore data quickly and easily, and provides a representation of the categories of a model and its hierarchical organization.